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Sending Mail Messages

This screen allows you to prepare new mail messages and replies.

Addressing your message
The subject field
Confirmation of reading
Confirmation of delivery
Keeping a copy of your message
Urgent messages
Encryption
Signatures
Editing your message
Attachments
Other message options
Importing text from other sources



Addressing your message

Just as the postal service needs an address to be able to deliver a letter, WinPMail requires an address to 
be able to send your electronic mail. Depending on your system and network you might be able to use any
of several types of address, each slightly different. The following are the types of addresses WinPMail 
recognizes, which you can enter in the To, CC or BCC fields.

Local addresses: You can enter the NetWare username of any user on your file server, or on any other 
file server to which WinPMail can deliver, using the standard NetWare syntax (ie, USERNAME, or 
SERVER/USERNAME). You can look up local users using the User Lookup function.

Internet Addresses: If your system has an SMTP gateway, then you can enter any valid Internet 
address in the address fields.

NetWare MHS Addresses: If your system has an MHS gateway then you can enter any valid NetWare 
MHS address in the address fields. If you are using an advanced MHS transport, you can access MHS
direcory services from the Addresses menu.

You can also prepare distribution lists, or lists of addresses you use frequently.



The To: field of a message indicates the primary recipient of a message



A CC (carbon copy) recipient of a message is someone you want to "listen in" to the message you are 
sending to the primary recipient. CC recipients receive the message normally but their addresses do not 
appear in the To: field of the message.



Use a BCC (Blind Carbon Copy) when you want to send a copy of your message to someone other than 
the primary recipient without the primary recipient knowing you have done so. Unlike CC, when you use 
BCC, there is no indication in the primary recipient's copy of the message that you have copied anyone 
else. BCC is very handy for office politics.



An SMTP gateway allows you to send mail to machines on the Internet (a huge world-wide computer 
network), or to machines which use the Internet RFC821/822 message protocols. Almost all Unix systems
and many mainframe and minicomputer systems can receive mail using this protocol.



NetWare MHS is Novell's messaging system. There are several versions of it for both NetWare and non-
NetWare environments. WinPMail supports all versions of NetWare MHS, including NetWare Global 
MHS. Ask your system administrator if you're unsure whether or not this option is available on your 
server.



The Subject field

Enter a short summary of your message in the subject field. Because the recipient will use the subject line
as a filing key, you should try to make it as descriptive and helpful as possible. When replying to a 
message, it is customary for the subject to be Re: <the original subject>: WinPMail will automatically 
format the subject this way for you when preparing replies.

The subject field can be up to 64 characters long.



Confirmation of reading

If you want to be notified when the recipient reads your message, check the confirm reading box in the 
message editing window. A small message will be sent back to you when the message is read. Note: the 
recipient must be using a version of Pegasus Mail for receipt confirmation to work. Some MHS mailers 
may also be able to provide receipt confirmations.

The System administrator can allow users to refuse confirmation of reading because many people feel that
it is an invasion of privacy. If you attempt to mail to a local user who will not provide confirmation of 
reading, a small dialog will appear when you send the message advising you of this. If you mail to a non-
local PMail user who will not permit confirmation of reading you will not receive any notification at all.

The confirm reading control is "sticky" - WinPMail will remember its setting from message to message 
and between sessions.



Confirmation of Delivery

Checking the confirm delivery box in the message editing window tells WinPMail to ask for confirmation 
that your message has been delivered successfully. Confirmation of delivery differs from confirmation of 
reading in that you are only advised that the message has been delivered to the recipient, not that it has 
been read.

Confirmation of delivery is always available if you are using NetWare MHS. You will never get 
confirmation of delivery on local mail (because WinPMail will tell you immediately if it fails to deliver 
your message). With Internet mail, you may or may not receive confirmation of delivery, because there 
are no guaranteed ways of asking for it.

The confirm delivery control is "sticky" - WinPMail will remember its setting from message to message 
and between sessions.



Keeping a copy of your message

If you want to keep a copy of the messages you send, check the copy self box in the message editing 
window. WinPMail will file a copy of your message in a folder called "Copies to self" which it will create
automatically when necessary.

If your "Copies to self" folder becomes too full, you can force WinPMail to create a new copyself folder 
by renaming the existing one. Note that you must change the short name as well as the long name when 
doing this.

The copy self control is "sticky" - WinPMail will remember its setting from message to message and 
between sessions.



Urgent Messages

Check the urgent box in the message editing window if you want your message to be sent at the highest 
priority available on the message transport your system uses. The effect of setting this flag will vary from 
system to system. Many MHS mailers will recognize it, as will some Internet mailers. Pegasus Mail 
displays urgent messages at the top of the new mail folder in red text, and sends a different new mail 
notification to the recipient to indicate that the message is urgent.

Note: You should use the urgent flag with care: urgent messages can be annoying, and overuse of the 
feature seriously impacts on its usefulness.



Encryption

If your message contains sensitive or private information, you might want to encrypt it. An encrypted 
message is scrambled, and can only be read by someone who knows the correct password.

To encrypt your message, click the encrypt button in the message editor. A small dialog will open into 
which you should enter the password for the message. The password should have from five to eight 
characters and is case-sensitive - so FOOBAR and foobar are different passwords. Press OK to add the 
password, or Cancel to remove it. WinPMail will encrypt the message using your password when it sends 
it.

The recipient must know the password, so you will have to make arrangements in advance to agree on a 
suitable choice. Don't forget the password! If you forget it, you will never be able to read your message 
again; even the author of WinPMail cannot break the encryption method it uses.



Signatures

A signature is a small fragment of text which WinPMail will automatically add to the end of messages 
you send. You should usually put your name, address and phone/fax number in your signature, although 
some people like to place a witty saying or other text there as well.

WinPMail supports separate signatures for each type of message you can send - Local, Internet and MHS:
you can create and edit signatures using the option on the preferences submenu of the file menu.

To suppress the addition of a signature to a message, click on the no signature button in the message 
editing window. You may need to omit your signature when sending mail to some Internet list servers.



Editing your message

Edit your message in the large message box at the bottom of the message editing window. The message 
text will word-wrap when it reaches the right hand margin, or you can press <Enter> to end a line at any 
time. You can cut text from and paste text into your message using the Edit menu.

You can check your spelling by positioning the cursor at the point in the message where checking should 
begin and selecting Check spelling from the Edit menu.

Ctrl+Y deletes the current line in the message, Ctrl+T deletes the word to the right of the cursor, and 
Ctrl+B reformats the current paragraph so that all its text falls between the left and right margin. Ctrl+D 
opens the Indenting dialog, which contains commands which allow you to reformat your text with 
indented left and/or right margins. These reformatting commands can also all be selected from the 
Message menu.

You can store abbreviations for commonly-used text in WinPMail's glossary, and expand it at any time by
pressing <Ctrl+/>.

Send your message at any time by clicking the Send button, or by pressing <Ctrl+Enter>.



Attachments

You can attach files to your mail message by clicking on the Attach button in the message editing 
window. The message editor view will change to one which allows you to choose files and control the 
way WinPMail will deal with them.

WinPMail will handle your attachments differently, depending on the destination of the message. You 
have considerable control over this process if you wish to have, although WinPMail's automatic handling 
is usually more than adequate for all situations.

Choose any of the following items for more information on attachments:

Selecting files to attach
Indicating the file type
Attachment encoding



Selecting files to attach

Before you select files to attach to your message, make sure that the File type and Attachment encoding 
fields in the dialog are set correctly, then use either of the two following methods:

Use the file and directory lists at the bottom of the window to navigate your disks. Double-clicking a 
filename will add it to the attachment list with the current settings of the file type and attachment 
encoding fields.

Type in the name (including an optional DOS path) of the file in the filename window. When you 
press <Enter> or click Add, WinPMail will add the file to the attachment list, or if you have entered a 
directory name, will change the file and directory list boxes to reflect the new directory.

You can remove attachments from the attachment list by highlighting them and clicking Remove. You 
cannot change the settings for an attachment once you have added it to the list - remove it and re-add it 
instead.



File type

You can tell WinPMail what type of file you are attaching by choosing from a predefined list of file types.
The file type information is optional and is currently used only for informational purposes - the recipient 
will usually see then file type when examining the list of files attached to the message.

Future versions of Pegasus Mail are likely to use the file type information to provide attachment viewing 
facilities, or to launch the original application with the attachment, so you should get into the habit of 
filling it in.

If you are uncertain of the type of file, you should use Unknown, the default choice.

Note: Pegasus Mail will not perform file conversion - WinPMail will not convert an MS-Word file to 
WordPerfect format even if you indicate WordPerfect format here - it will simply convey the wrong 
information.



Attachment encoding

When you send an attachment, it cannot always be transmitted as-is. Sometimes it is necessary to package
the attachment in a particular way so that the mail transport system or the recipient's mailer can 
understand it. WinPMail will always make sensible default choices about attachment encoding - you 
should only need to change the attachment encoding in very special cases. WinPMail supports the 
following attachment encodings:

WinPMail decides. The default setting, this tells WinPMail to do whatever is appropriate based on the 
way it sends the message. Attachments to local and MHS addresses will not be encoded in any way, 
while attachments to Internet addresses will be uuencoded prior to transmission.

No encoding. Instructs WinPMail not to encode the attachment at all. This is an extremely dangerous 
choice in some cases, particularly for Internet mail. Use it only if you know that the attachment is a 
plain text file with no high bit characters.

ASCII text. Indicates that the file is plain text with no formatting or high-bit characters. WinPMail 
will actually send the attachment as a separate message rather than as an attachment.

UUencoding. A scheme used widely on the Internet. If you are mailing via the Internet, or to a user on
a Unix or mainframe system this encoding is a good choice.

BinHex. Used heavily in the Macintosh world. BinHex is a good format, containing a certain amount 
of error checking and compression. Because it is not widely used outside the Macintosh world, you 
should check in advance that the recipient is able to deal with BinHex-encoded files.

MIME Encodings:    MIME (Multipurpose Internet Mail Extensions) is an Internet standard for 
multimedia mail which allows different mail applications to exchange a variety of types of 
information. If you select any of these MIME encodings, WinPMail will attach the information 
necessary for other applications to be able to decode the file. You must choose an appropriate 
translation - selecting "GIF image" for a TIFF file will not cause Pegasus Mail to convert the file: it 
will simply be sent in the wrong format. Pegasus Mail will choose basic MIME encoding 
automatically if you set encoding to "WinPMail decides" and have checked the "Use MIME features" 
control in the "Special" screen of the message editing dialog.



Other message options

Select Other message options from the Message menu, or click on the "Special" button in the message 
editing dialog and the screen will change to a dialog which allows you to control less frequently-used 
features for your message.

BCC. Enter any BCC. addresses in this field.

Send replies to. If you want replies to your message to go to an address other than your own, enter 
that address in this field.

Message is obsolete after. If your message is only meaningful for a certain length of time, enter the 
time after which it is obsolete in this area. Obsolete messages appear grey in the folder window, and 
there is a browser command which will purge all obsolete messages. Obsolete mail mail also be 
purged by utilities run by the system manager.

Message width. This field allows you to specify the average length of a line of text in your message. 
WinPMail will adjust the margin of the message editor so that approximately the number of 
characters you specify will fit on a line. You cannot enter a width wider than the current width of the 
editing window. Click use as default to use the value you enter for all future messages.

Average tab width. By default, WinPMail obeys the standard Windows convention that the <Tab> key
moves from field to field in a dialog. If you enter a width in this field, however, WinPMail will insert 
the <Tab> characters in the message instead. You can only change the tab width if tabs were enabled 
when you started the message. You can enable tabbing for all future messages by clicking use as 
default. The width you enter is an average based on the average width of characters in the current 
font; it will only be exact if you use a monospace font such as Courier.

Use MIME features for Internet and local mail    MIME is an an Internet standard which allows 
mailers on different systems to exchange binary data and messages using International characters. If 
you check this control, WinPMail will use MIME encodings to represent accented and special 
characters, and to package attachments so that other MIME-compatible mail systems can read and 
convert them. MIME is a very powerful standard, and the only time you should not check this control 
is if you believe your correspondent may not be using a MIME-compatible mail system.

Prompt copy to self    If checked, Pegasus Mail will ignore (and grey out) the copyself control in the 
message editor and when you click the Send button will ask you whether or not you want to keep a 
copy of the message.This value is "sticky" - that is, WinPMail will remember it between sessions.

Prompt copy to self folder  If checked and you indicate you want to make a copy to self, Pegasus Mail
will open the folder selector and ask you to select the folder into which the copy should be placed. If 
unchecked, Pegasus Mail will use the copy to self folder defined in your General settings preferences.
Like the prompt copy to self option, this value is remembered between sessions.



Importing text from other sources

You can add text from other applications to your message in two ways.

Cut and paste. You can use the standard cut, copy and paste commands on the Edit menu to move text 
around within Windows.

Import menu option. The Import file into message option on the Message menu allows you to read a text 
file into your message. A dialog will appear which allows you to navigate using standard file and 
directory lists, or type the name of the file in directly. Note: the file must be a text file for this option to 
work. Word processor files are usually not text files.



Distribution Lists

WinPMail can accept up to 180 characters in any address line. If you need to send a message to more 
addresses than will fit in this space, or you have lists of users to whom you mail regularly, you can create 
distribution lists.

A distribution list can be any text file containing addresses, one per line, but it's generally easier to use 
WinPMail's distribution list manager, which you can access by pressing the button on the button panel, by
pressing <F6>, or by selecting Distribution lists from the Addresses menu.

Creating a distribution list
Distribution list options
Using distribution lists



Creating a distribution list

To create a distribution list, press <F6> and click on the New button in the selector window. A dialog will 
open prompting you for a long name for the list and an optional file name. Complete the dialog then click 
OK. You will be returned to the selector window.

Now, hightlight the list you created and press the Edit button. A window will open in which you create 
and control your distribution list. The title you gave your list when you created it appears in the Title 
field.

To add addresses to your distribution list click in the address list area and either type in the addresses or 
select them from address books or the local user list. Make sure that you have only one address per line in
the list. Any valid address can be entered in the list.

Distribution list options



Distribution list options

There are several ways you can control and customize the operation of your distribution lists.

To field: Entering an address in this field will force PMail to suppress enumeration of addresses when you
use the list. Instead of showing every member of the list, the To: field will contain only what you enter 
here.

Reply to: If you want to direct replies to list mailings to a particular address, enter it here. A reply-to field 
you set in the list will override any in the message.

Confirm reading, confirm delivery, urgent, no signature: These controls duplicate the same features in the 
message editor. If you set them for the distribution list they will override the values you use when you 
compose the message.



Using a distribution list

Tell WinPMail to use a distribution list in one of three ways:

1: While composing your message, open the distribution list selector by clicking the button in the button 
panel, by pressing <F6> or by choosing Distribution lists from the Address menu, and double-click on the
address you want to use. WinPMail will paste the appropriate file name into the address field of your 
message.

2:    Leave the distribution list manager window open and drag the lists you want to the address field in 
your message.

3: Type an '@' followed immediately by the DOS path to the file containing the distribution list. You will 
not normally use this method, but it may be convenient if you have a mailing list in a suitable format 
which was not created in WinPMail.



Glossaries (abbreviations)

WinPmail allows you to store abbreviations for commonly-used text strings which you can expand at any 
time with a single keypress. To create a glossary entry, choose Edit/create from the Glossary submenu of 
the Edit menu.

In the Glossary dialog, a list of abbreviations appears on the left-hand side of the screen, while the full 
text of the currently-selected abbreviation appears in the edit window to the right. To change a glossary 
entry, simply select it in the list and edit it in the editing window. WinPMail. Adding a glossary entry is 
equally simple - just click the Add button, provide an abbreviation, and edit as before. You can copy and 
paste into your glossary texts using the buttons in the dialog.

To expand a glossary entry in your message, simply type the abbreviation, make sure the cursor is at its 
end, then press <Ctrl+/>. In WinPMail 1.0 you can only expand glossary entries in the message editor. 
Future versions will allow you to expand them in any text field.



Browsing mail

The folder browser allows you to manage the mail you receive. It provides functions for moving, copying,
deleting, forwarding, printing and replying to messages. Special options and functions for sorting folders 
are located on the Folder menu which appears at the end of the menu bar when a folder window is 
frontmost.

The folder selector
Copying and moving messages
Deleting messages
Forwarding messages
Printing messages
The Folder menu



A mail folder is simply a place where mail messages are stored. The new mail folder is a special folder 
which changes as you receive, read and delete mail, but you can also create other folders for long term 
storage of messages you wish to keep. Folders can have long descriptive names to aid in filing.



The folder selector

When you ask to open a folder, or if you choose the Move or Copy options in the folder window, the 
folder selector will open. In this dialog you can create new folders, rename existing ones and delete 
folders you no longer require.You can also create Trays, which are a special kind of folder which can 
contain folders and other trays.Trays allow you to organize your mail into a hierarchy, or to group related 
topics and folders in their own areas.

The folder selector shows a list of all the folders and trays available to you. Folders in the list which 
appear in blue are system folders: you can read from them, but you might not be able to alter their 
contents. You can select items from the list using the mouse, or by typing the first few characters of their 
names. To open a tray, highlight it and press <Enter>, or click on the Open button, and its contents will 
appear in the list indented one level.

At the right-hand edge of the entry for each folder is a pair of numbers, representing the number of 
messages in the folder and the number of unread messages in the folder respectively. Unread mail can 
appear in folders as a result of new mail filtering rules, or when you copy a message you have not read 
from the new mail folders. Folders containing unread mail appear in the list in green.

Special options    When you click the Special button in the folder selector, a popup menu will display 
offering the following four options; you can dismiss the menu without selecting a choice by pressing 
<Esc> or clicking the mouse outside the menu.

Reindex folder    From time to time, a folder's index file may become corrupt, which can result in errors 
when you attempt to open it. Highlight the folder and select this command to force Pegasus Mail to 
rebuild the index file. Reindexing will work reliably if the actual messages in the folder are intact, but 
may result in the loss of some status information (such as whether or not you have replied to a message, 
or forwarded it). A side-effect of rebuilding a folder is that some deleted messages may reappear the next 
time the folder is opened.

Compress folder    When you delete a message from a folder, Pegasus Mail does not immediately reclaim 
the space it occupies; instead, it waits until you have deleted around 20000 characters from the folder then
recovers all the space in a single pass. This deferred compression improves the performance of the 
program at the cost of some disk space. Select this option to force Pegasus Mail to compress a folder. 
Compression is always a safe option and does not result in the loss of information.

Move entry    Select this if you want to move a folder or tray to another tray. The highlighted folder or tray
will be removed from the list and information about it will be saved in a disk file (called 
TRAYSAVE.PM) in your home mailbox. Once you have chosen the Move command, each time you click
the Special button again, the Move option will be replaced by a Retrieve option, allowing you to insert the
moved entry into the list. Navigate to the place in your tray hierarchy where you want the item to appear, 
then choose Recover from the special menu and Pegasus Mail will insert the saved item for you. It is safe 
to exit from Pegasus Mail without recovering the entry - you can do it at any time after you have moved 
it.

Check tray list    If you create folders using an old version of Pegasus Mail after you have run WinPMail 
1.1, the folder will not appear in the tray list, because WinPMail stores the tray structure in a way which 
the old version of Pegasus Mail does not understand. Selecting this option tells Pegasus Mail to compare 
its tray list (the list of all folders and tray which it maintains) with the folders which actually appear in 
your home mailbox. If it finds any folders which are not in the tray list, it will add them to the main tray 
for subsequent use. This command is completely safe and may be used routinely if you wish.





Copying and moving messages

If you want to make a copy of message in a mail folder, or to move the message from the current folder to
another, click on the Copy button or the Move button. The folder selector will open listing the available 
folders. You can create a new folder if you wish, or else double-click on the destination folder.

If the message you are copying has not been read, the unread messages counter which shows for the 
folder in the folder selector will increase by one.



Deleting messages

To delete messages you no longer need, highlight them in the folder and click the Delete button, or press 
the <Del> key.

Deleted message tracking: WinPMail has a preferences option which can allow you to recover mail 
messages you delete accidentally. If you have checked Preserve deleted messages until exit in your 
preferences WinPMail will not delete messages from the folder - instead it will move them to a special 
folder called Deleted messages which it will create as necessary. When you exit from WinPMail, the 
deleted messages folder is removed and the messages are deleted once and for all. Any time up to the 
point when you exit from WinPMail you may open the deleted messages folder and move or copy 
messages you wish to recover to other folders.

Note: you should not enable deleted message tracking if you are running in an environment with low or 
restricted disk space.



Forwarding messages

If you wish to refer a message to another person or people, then highlight it in the folder list and click the 
Forward button, or press <F>. A small dialog will open prompting you for the address to which the 
message should be forwarded. If you click Edit before forwarding, then a message editor will open 
allowing you to change the contents of the message before it is sent, otherwise it will be forwarded at 
once.

Note: it is a limitation of WinPMail v1.0 that you cannot pick addresses from address books or other lists 
in the forwarding window - you can only type the address in. This restriction is temporary and will be 
removed in the near future.



Printing messages

You can print messages from the message reader or from the folder list by pressing <Ctrl+P>, or by 
selecting Print from the file menu. The message reader also has a Print button.

When you ask to print a message, the print setup dialog will appear showing the last settings you used. 
WinPMail remembers your print settings from session to session. The currently selected printer (or the 
default Windows printer if this is the first time you have printed your message) appears in the list control. 
You can select other installed printers by clicking on the down arrow at the right-hand end of the control.

The Margin fields allow you to specify a printing margin for the Top/Bottom and Left/Right of the page. 
The default is 20mm (one inch = 25.4mm) all round. WinPMail will not permit you to set margins 
narrower than 10mm. 

The Font button allows you to select a font from those supported by your printer.

The Setup button brings up the standard Windows printer setup dialog, which will vary from printer to 
printer.



The folder menu

When a folder window is frontmost, a Folder menu appears at the right of the menu bar. The folder menu 
contains options which are less frequently-used or are more specialised than the button functions in the 
window.

Searching for text in the folder
Sorting the contents of the folder
Extracting messages to files
Special folder options

The last entry on the menu allows you to select the font the folder window will use to display the list. This
setting is global to all folders and is remembered from session to session. You cannot choose very large 
fonts for the folder display without truncating some of the information it shows. A 14-unit font is 
normally a good size.



Searching for text in a folder

The Find and Find again options on the folder menu allow you to search the contents of the current folder 
for a piece of text. Type the text you want to look for in the editing field. The text can contain * and ? 
wildcard characters. Unless you use wildcard characters, the search is case-sensitive (that is, WinPMail 
and winpmail are regarded as different).

Search message headers only: If you want WinPMail to restrict its search to the special headers at the 
start of the mesage, check this box. Searching headers only is considerably faster than searching the 
whole message, and is appropriate if you are interested in the subject of a message or who it is from.

Mark all matching messages: Usually WinPMail opens a message reader and displays the first message it 
finds which matches your search criteria. If you want to select all messages in the folder which match 
your criteria instead of reading them, click this box. This option is handy if you want to tag all messages 
on the same subject for moving or copying.

Hint - searching for a specific header: If you only want to search for a particular header containing your 
search string, make sure that search message headers only is checked, then enter the search text like this 
example, where we only want messages where the From: field contains the word Otago:

From:*otago*



A wildcard character is one which matches any character or group of characters in the text searched. In 
WinPMail the ? character matches any single character (so "?illy" will match both "Willy" and "Billy"), 
while the * character matches any number of characters (so "j*on" would match "johnson", "johnston" or 
"john's son").



Extracting messages to files

Select this command if you would like to save the text of a message or messages to files on your hard disk
or file server. What happens when you select this option depends on whether or not you have selected 
more than one message in the folder. If you have only selected one message, the Pegasus Mail will simply
ask you for a filename and will save the contents of the message to that file. If you have more than one 
message marked, then Pegasus Mail will open a dialog asking you to choose from three options:

Extract all messages to a single file    If you choose this option, then Pegasus Mail will ask your for a 
filename and will save the text of all the marked messages in the same file, one after the other in the order
they appear in the folder.

Extract messages to separate files, asking for names    Choose this option and Pegasus Mail will ask you 
for a filename for each marked message. You will usually use this option when it is important that you 
control the names of the files containing the message text.

Extract to separate files, creating unique names for each    If you choose this option, then Pegasus Mail 
will ask you to enter a single filename. It will then take the filename you supply and create unique 
filenames based on it, saving the text of each message in a separate file. Pegasus Mail creates the unique 
names by removing any file extension you supply and adding a numeric extension starting at 000, adding 
1 to the extension for each file.You can extract a maximum of 999 messages to files using this command.



Sorting folders

The second group of entries on the Folder menu allow you to specify how the folder should be sorted. The
default for folders is Sort by date. A check mark appears next to the entry which indicates how the folder 
is currently sorted.

WinPMail remembers the last sorting option you selected from session to session.



Special folder options

The last entry on the Folder menu has a submenu containing some specialised functions.

UUdecode message: Sometimes WinPMail will be unable to recognize that a message is actually an 
attachment sent using a special encoding method called uuencoding. This usually happens if the 
attachment was sent across the Internet by someone using a mail system other than Pegasus Mail. If you 
receive a message like this, you can force WinPMail to decode it by highlighting it in the list and 
selecting this option. WinPMail will prompt you for a filename and will attempt to decode the message 
for you.

Un-BinHex message: BinHex is another special transmission format like uuencoding (see above), 
commonly used on Apple Macintoshes. If you receive a BinHexed message which WinPMail does not 
recognize as BinHexed, you can force it to unpack it using this option.

Note: BinHexed files from Macintosh users may be useless to you on a PC. The Macintosh has a filing 
system quite unlike that of any other computer and its files are often only usable on other Macintoshes. 
Some programs such as WordPerfect and MS-Excel create data files which are compatible on both 
platforms, but not all do. If you find you cannot use the attachment when you extract it, this may well be 
the reason.

Add sender to distribution list  When you select this command, Pegasus Mail will open the distribution 
list selector and prompt you to select a list. The addresses of the sender of every marked message in the 
folder will be added to whichever distribution list you select. WinPMail will not duplicate an address 
which already appears in the list.

Remove sender from distribution list    This command removes the sender of every marked message in the 
folder list from whichever distribution list you select.

Delete all expired messages: WinPMail allows you to set an expiry, or obsolescence date for a message - 
a date after which the message is meaningless; messages which are past their expiration dates appear grey
in the folder window. This command instructs WinPMail to delete all expired messages from the folder, 
and only works in the New Mail folder.



Address books

WinPMail's address books allow you to store electronic mail addresses and other information about 
people with whom you correspond. You can create as many address books as you wish, and the system 
administrator can also create address books which everyone can see (these appear in blue in the address 
book selector window).

The address book selector
Creating addressbook entries
Using addressbook entries in your mail
Searching address books
The address book menu



The address book selector

When you click on the address books button, or choose address books from the Addresses menu, the 
address book selector window will open. In this dialog you can create new address books, rename 
existing ones and delete address books you no longer require.

The selector shows a list of all the address books available to you. Address books in the list which appear 
in blue are system-wide address books available to all users: you can read from them, but you might not 
be able to alter their contents.

To open an address book, either double-click its entry, or highlight it in the list and click on the Open 
button.

Naming address books: when you create an address book in the selector, you can give it any name you 
wish up to a maximum of 50 characters. There are no restrictions on the names you can use in the address 
book long name. If you choose to specify the short name (or filename) for the address book, you must 
enter a legal DOS filename no longer than 8 characters with no extension. Usually, you will leave the 
short name field blank and allow WinPMail to choose a filename for you.



Creating address book entries

When you have opened an address book, a window will open listing the contents of the book in an 
abbreviated form. If you click on an entry in the list, all the details from that entry will appear in the 
information pane at the bottom of the address book window.

To add an entry to your address book press the Add button. A simple data-entry dialog will open 
presenting you with a blank entry template. Fill in the fields and when you are satisfied with what you 
have entered, click the OK button. The fields which you must complete in this screen are the following:

Name (alias): The person's name. You can use what you enter in this field as an address in any address 
field - it is generally easier to remember that someone is called Peter Smith than to remember his address. 
This use of the name as an address is called aliasing. This field may not contain a comma.

Key: A short search key for the entry. WinPMail allows you to sort the address book either by name or by 
key, so the key field gives you an alternative sorting option.

E-mail address: The person's electronic mail address. Any single valid address can be entered in this field,
including distribution lists and NetWare groups. You may not use an alias in this field.

All other fields in the address book are yours to use in any way you wish.



Using address book entries in your mail

You can use your address books in your mail in three distinct ways

1: You can double-click on an entry in your address book to start a new mail message using that address 
and any others selected in the book.

2: You can click on the Paste button on the address book window. Any highlighted addresses will be 
copied into the last active field in the message you are editing.

3: You can drag the address entries you want to use to any edit control and drop them there. Note that the 
edit control need not be in WinPMail - it is possible to drag addresses from WinPMail to edit controls in 
other applications, such as the Windows Notepad program.

Depending on the setting in the address book menu, WinPMail will paste either the alias (the default) or 
the actual e-mail address into the destination field: you may use either approach depending on your 
preference.

Limitations:    Most address fields in WinPMail can only accept at most 180 characters. If you have 
selected addresses with more characters than will fit in the field, WinPMail will issue a warning. When 
this happens, you might have to consider creating a distribution list.



Aliasing happens when you use the name field from an address book instead of the e-mail address. 
WinPMail will accept either as an address: if you use the name, then WinPMail will look up the real e-
mail address at send time. You may prefer to use aliases over e-mail addresses because it is generally 
easier to remember someone's name than their address.



Searching address books

The quickest way to search your address book is to type the first few characters of the name or key you 
want to find. Depending on the current sort order of the address book WinPMail will move the highlight 
to the first entry in the book with a key or name which matches what you type. This process is called 
speed searching.

For more comprehensive searching, the address book menu contains a Find command which you can use 
to locate or select entries in your address books. When you choose Find, a small dialog will open asking 
what you want to search for. Enter the string you want to find. If you want WinPMail to search the whole 
address book marking all entries which match your criteria, click the select all matching entries button.

You can repeat the last search you made by selecting Find again from the address book menu. The search 
text is global, so you can search in one book, then open another and choose Search again to continue your
search in the new book.



The address book menu

When an address book is the frontmost window in WinPMail, the Addressbook menu option becomes 
available at the right of the menu bar. This menu contains actions and commands specific to address 
books.

The first two commands, Find and Find again, allow you to search for text in the address book.

The next two options control the sort order for the addressbook. Unless the address book is a system-wide
entry, the sort order is remembered for each address book separately between sessions. The sort order 
which is currently active shows a checkmark in the menu.

The final three options on the menu control the way WinPMail will use addresses from the address book. 
Like the sort order, these settings are local to each non-system address book and are remembered between
sessions. The first two options in the group allow you choose whether WinPMail should paste the alias or 
the actual e-mail address into messages when you drag and drop or press the Paste button. The default is 
to paste the alias. 

The last option on the menu allows you to tell WinPMail whether or not to resolve aliases in this address 
book. Alias resolution is the process of taking a name and finding the e-mail address which matches it 
from the address book at send time. The process of alias resolution can take quite a while if you have 
many or large address books, so you may want to disable it for some or all of your books. By default 
WinPMail resolves aliases in all address books.



The button panel

WinPMail's button panel is a set of tools which provides access to the most commonly-used parts of the 
program at the click of a button. Depending on the setting you specify in your Button Panel Preferences 
(see under the File/Preferences menu), the button panel can appear as either a fixed toolbar beneath the 
main menu (the default) or as a small floating window in either horizontal or vertical format.

WinPMail remembers the location and state (open or closed) of the button panel between sessions. You 
can also choose between having the button panel as a toolbar, or as a floating window in vertical or 
horizontal format using the option in your Preferences.

When the button panel is active as a toolbar, the buttons have the following functions:

Compose a new message
Read new mail
Open/manage mail folders
Open/manage address books
Open/manage distribution lists
Open the local user list
New mail filtering rules
Use the noticeboard system
Cut selection to the clipboard
Copy selection to clipboard
Paste the contents of the clipboard
Save or write to disk
Retrieve or import from disk
Print
Select font

When the button panel is active as a floating window, the buttons have the following functions:

allows you to start a new mail message

allows you to browse your new mail folder

allows you to browse other mail folders

allows you to manage your address books

allows you to manage your distribution lists



Preferences

WinPMail allows you to customize many aspects of the way it works to suit your own tastes. The settings 
you make which control this are called your Preferences, and are stored in a file called PMAIL.INI in 
your newmail directory. The file is a plain text format and can be edited using any text editor (such as the 
DOS EDIT command, or the Windows Notepad editor).

Preferences fall into two classes - implicit preferences, such as the location of windows on the screen and 
the values you set in the controls in the message editor. WinPMail remembers implicit preferences 
without you having to do anything more.

The other class of preferences are explicit preferences, or ones where you actually instruct WinPMail to 
operate in a particular way. Explicit preferences are changed using the Preferences submenu of the File 
menu. The following options are available there:

General settings
Advanced settings
NetWare MHS settings
Signatures
Home mailbox location
Extended features



General settings

The following items can be changed in the General Settings dialog:

Personal name: WinPMail attaches whatever you enter here to your address when you send messages, 
making it easier for the recipient to identify who you are. You should make this entry simple and clear. 
Your personal name should consist only of letters and digits.

Open new mail at startup:    If you check this box WinPMail will automatically open your new mail folder
for you when you run it.

Preserve deleted messages until exit:    If you check this box, WinPMail will save any messages you 
delete in a special folder called Deleted Messages which will be cleared when you exit; this option can 
allow you to save messages deleted accidentally.

Ask for confirmation before deleting:    If you prefer that Pegasus Mail does not ask you to confirm that 
you really want to delete messages, uncheck this control. If you uncheck this control, you increase the 
risk of accidentally deleting messages you meant to keep, so we recommend you consider turning the 
Preserve deleted messages until exit option on.

Leave read new mail in newmail folder:  Usually when you close the new mail folder, Pegasus Mail 
moves all the messages you have read but left in that folder to your Main Folder. If you would prefer new 
mail to stay in your new mail folder until you explicitly move or delete it, check this control.

Ask for NetWare password at startup:    Check this and WinPMail will prompt you for your NetWare 
password when you run it. It will not run unless you enter the password correctly. This option adds 
security to your mail if you are away from your desk a lot. This control has no effect in non-NetWare 
environments and will not be available.

Encrypt copies to self of encrypted mail:    If you check this control, Pegasus Mail will encrypt copies to 
self of messages you send encrypted, using the same key as the message. If you subsequently open them 
in your Copy to self folder, you will need to know the password before you can read them. If this control 
is unchecked, then copies to self will always be stored as plain text whether or not the message itself is 
encrypted.

Offer advanced options for replies:    WinPMail has an alternative reply dialog which allows you to select 
particular addresses from the original message for your reply. If you want to use the advanced reply 
dialog instead of the default simple reply dialog, check this box.

Save desktop state between sessions:  If this is checked, WinPMail will remember the folders, address 
books, distrubution lists and other windows you have open at the end of a session, and will automatically 
reopen them at the start of the next session.

Folder for copies to self:    If you click on the Select button, WinPMail will open the folder selector and 
allow to create or select a folderwhere your copies to self will be stored. By default the folder is called 
"Copies to self" with the DOS filename "copyself".

Default reply address:    If you want to specify an address which WinPMail will automatically copy to the 
reply-to field of every outgoing mail message, enter it here. There is usually no need to use this option -
you might use it if you routinely prefer to receive your mail on another system for instance.



Advanced settings

The advanced settings dialog lets you alter some of the more technical aspects of the way Pegasus Mail 
operates.

New mail folder poll time:  This option controls how frequently Pegasus Mail should scan your new mail 
folder for new mail while the newmail window is in the foreground. The default is to update the list every
three seconds, but this can generate a lot of Network traffic and can degrade your machine's performance, 
especially if you are connected to your server across a slow link. Setting this field to -1 will disable new 
mail polling altogether - the new mail window will only be updated when you explicitly choose "New 
mail" from the "File" menu, or click the "New mail" Icon in the toolbar.

Organization:  This field is only used if you are not connected to a NetWare server; you can enter a name 
in this field and Pegasus Mail will place it in the "Organization" field of all mail sent locally and via 
gateways on your system.

Internet mail time zone:  Again, this field is only meaningful if you are not connected to a NetWare 
server. You should enter your time zone in here expressed as a plus or minus offset from Greenwich Mean
Time, and Pegasus Mail will then use it in the Date field of messages you send. Example: New Zealand is
11 hours ahead of GMT, so the proper value for this field would be +1100.

Accept "confirm reading" requests: This option only applies when you are not connected to a NetWare 
server. It determines whether Pegasus Mail should send automatic answers indicating that you have read a
message when the "request confirmation of reading" flag is set in that message. If you uncheck it, Pegasus
Mail will never send confirmation of reading. If you are running on a NetWare LAN this option will be 
greyed and you cannot change it - instead, alter the option in your Extended features preferences.

Send enclosures instead of attachments:    When you send mail with attachments to Internet addresses, 
Pegasus Mail usually sends each attachment as a separate message. There are good historical reasons for 
this behaviour, but many users find it unintuitive.If you would prefer Pegasus Mail to encode attachments 
onto the end of your message and send only the single transmission, then check this control. Note: 
enclosures are harder for mail programs to find than attachments and can confuse some mail systems.

Winsock loading options:  WINSOCK.DLL is a program which provides Pegasus Mail with access to 
TCP/IP networking services on your machine. By default, if Pegasus Mail can find a WINSOCK.DLL on 
your system, it will load it and make TCP/IP-based mail services available to you using it. If you do not 
use these features of Pegasus Mail, or if you see errors when Pegasus Mail tries to load the DLL, you can 
disable the automatic loading by clicking the Never button. If you are using WINSOCK across a slow 
dialup line, such as a SLIP link, you may have to check the Load only on demand button: this tells 
WinPMail to make TCP/IP based services available but only to load WINSOCK.DLL when it actually 
needs to use it, then unload it when it's finished. You might also want to use demand loading if your 
machine has only very limited memory. In normal use on an Ethernet LAN, however, you should check 
the Always button so that Pegasus Mail can get the highest performance from your TCP/IP network.

Telltale Window settings:    The telltale window appears when you minimize WinPMail on your desktop, 
and reports new mail in your new mail folder. If you would prefer that Pegasus Mail did not open the 
telltale window when minimized, uncheck the Enabled button. When the telltale window is disabled, it is 
up to you to check periodically and see if you have new mail. If you want the telltale window always to 
appear in front of all other applications on your system so you can always see your new mail count, check
the Always on top control.



The telltale window has three reporting modes - total, new, and summary. In total mode, it shows the total
number of messages in your new mail folder. In new mode, it shows only the number of messages which 
have arrived since WinPMail was minimized. In summary mode it shows a breakdown of the contents of 
your new mail folder. In all modes the count appears in red if new mail has arrived since WinPMail was 
minimized. You can change the telltale window mode by clicking on it. WinPMail remembers the telltale 
mode between sessions.



NetWare MHS preferences

If a version of Novell's MHS transport is installed on your system, then this option allows you to 
configure the way WinPMail will interact with MHS for you. In general, the options in this screen are 
quite complex and you should change them only if instructed to do so by your MHS administrator.

My NetWare MHS username:    This is the username by which MHS addresses you. It may be the same as 
your NetWare username but need not be. If you are using an SMF-71 transport such as NetWare Global 
MHS, you can enter a full SMF-71 address (up to 128 characters long) in this field. You may need to enter
a complete address here if you are not a member of the default MHS workgroup.

Mailbox name:    This is the name of the directory in the MHS tree where your MHS new mail folder is 
located. If you are using MHS 1.5, it will usually be the first eight characters of your NetWare username 
(which is the default WinPMail uses) but it may be different, and is likely to be different if you are using 
an SMF-71 transport.

New mail folder:    This is the name of the folder in your new mail folder where WinPMail should expect 
to find your new mail. In technical terms, this field should contain the name of your preferred mailer 
which may or may not be PMail.

Check the MHS newmail folder:    By default, MHS creates a new mail directory for every user called 
MHS, and makes this directory the preferred mailbox for the user. Checking this control tells WinPMail to
check the MHS new mail folder as well as any other you name in the New mail folder field. Checking this
option is harmless at worst, although it may slow down checks for new mail a little bit.



Signatures

A signature is a small fragment of text which WinPMail will automatically add to the end of messages 
you send. You should usually put your name, address and phone/fax number in your signature, although 
some people like to place a witty saying or other text there as well.

WinPMail supports separate signatures for each type of message you can send - Local, Internet and MHS.



Home mailbox location

Your home mailbox is where all your mail folders, distribution lists, address books and other PMail 
related files (except unread new mail) are stored. By default, it is located in a special directory on the file 
server, but you can specify an alternative location for it using this option.

Note: before using this option, make sure that all windows in WinPMail are closed except the button 
panel (which can also be closed but does not have to be).

You may want to change your home mailbox location if you have limited space on the file server, if you 
are concerned about the privacy of your mail, or for other reasons. You can also have more than one 
mailbox and change between them using this dialog - you might want to do this if you received mail at 
your address for more than one person or organization.

To change your home mailbox location, type in the new path in either DOS or NetWare format. If you 
want to change the location but leave all your mail files where they are, make sure that the move mailbox 
contents to new location button is not checked (this is how you would implement more than one mailbox 
as described above). If you have moved your home mailbox but want to revert to the original location on 
the file server, press the Default button.

If you have chosen to move the contents of your home mailbox, WinPMail will do so as soon as you click
OK.



Extended features

Extended features are special Pegasus Mail features which you only have if the system administrator has 
explicitly granted them to you. If you have been granted access to extended features, then the Extended 
features menu option in the Preferences sub-menu will be available, other wise it will be grey and you 
cannot select it. Choosing this option opens a dialog which allows you to change the following:

Autoforwarding: Pegasus Mail supports autoforwarding, or the redirection of your mail to another 
account. You can autoforward either mail delivered to you from local addresses, mail received from the 
Charon or Mercury Internet gateway, both or neither. It is possible to forward one type of mail but not the 
other. To set autoforwarding, place the forwarding address in either or both of the available autoforward 
fields. You can forward local mail to any address WinPMail can understand including NetWare groups 
and distribution lists. Internet mail can only be forwarded to simple local addresses or to Internet 
addresses. Mail arriving via NetWare MHS cannot be autoforwarded.

Deliver mail even if autoforwarding: check this box if you want Pegasus Mail to leave a copy of mail as 
well as forwarding it when you have autoforwarding addresses set. This option has no effect if you are not
forwarding your mail.

Allow 'confirmation of reading' requests. If you uncheck this box, then WinPMail will not return 
confirmation that you have read messages when it is requested. Local users will be told the moment they 
send the message that no confirmation will be supplied, but Internet and MHS mail will receive no such 
notification.

Advise of new mail via broadcasts: When this box is checked, Pegasus Mail will send a NetWare-style 
broadcast message to indicate that a new mail message has arrived. If you find the broadcast messages 
annoying but do not want to use the NetWare CASTOFF command to disable them, uncheck this box..

Disable mail delivery to this address: If checked, it will not be possible to send mail to this address.



Reading mail

To read a message in a folder, either double-click on it or select it and press the Open button.

While you are reading a message, a button bar with most of the options available in the folder window 
appears. There is also a Print button, which has the same effect as choosing Print from the File menu, and
a pair of buttons marked Next and Prev. The Next button replaces the message in the reader window with 
the next message from the folder, while the Prev button replaces the message with the one before it in the 
folder. If you hold down the Shift key while you press Next or Prev, the message you are leaving will be 
marked in the folder selector before the new one is loaded.

The Copy command on the Edit menu will copy lines from the message reader for pasting elsewhere. By 
using the Ctrl key while selecting lines you can select separate groups of lines simultaneously in the 
message, and copy them all with one command.

Options specific to the message reader appear in the Message menu.



The Message menu

While reading mail, the Message menu appears at the right of the menu bar. The menu offers four options 
specific to the message reader:

Save window size:    When you choose this option, WinPMail will save the current size of the message 
reader window to your preferences. All future message reader windows you open will open at this size. 
You cannot save the location of a message reader window because doing so would result in messages 
overlapping onscreen, thus being difficult to select.

Show all headers:    By default, WinPMail displays only headers in the message which are meaningful to 
the reader, suppressing all others. If you need to see the message exactly as it was delivered, with its 
headers intact, select this option. Note: Unlike the DOS version of PMail where the show all headers 
option is global and affects all subsequent messages, WinPMail only applies this option to the current 
message.

Extract message to file:    If you want to make a copy of this message in a DOS text file, perhaps for 
inclusion in another program, then select this option. You will be prompted for a filename - when you 
click OK, WinPMail will extract the contents of the message to the file.

Font...: Use this option to change the font you use to view messages. This change is global, and affects all
messages already open and subsequently opened in WinPMail.



Headers are the special set of lines at the start of a mail message which contain addressing and other 
machine-readable information about the message. Headers are rigidly formatted and vary widely from 
system to system; many headers in a message are only of interest to the mail transport system and are 
meaningless to a human reader.



The MHS Directory Service

If your system has an MHS SMF-71 message transport such as Novell's NetWare Global MHS, then the 
directory service provided by that system (called the Extract File) is available to you from within 
WinPMail. To open the MHS Directory Service, choose the entry on the Addresses Menu.

The MHS directory service list behaves like a read-only address book: you can double-click on an entry 
to start a new message using the entry as an address, you can drag addresses from the list window to any 
address field, or you can click on the Paste button to paste the selected addresses into the last address 
field you were using.

You can also speed search through the list by typing the first few characters of the name you are looking 
for.

For technical reasons, you should close the extract file window as soon as you can after using it, since 
NetWare MHS may not be able to update the list while you have the file open.



Built-in TCP/IP network mail services

WinPMail has built-in support for mail services accessed using TCP/IP (Internet) network protocols 
called POP3 (Post Office Protocol) and SMTP (Simple Mail Transfer Protocol). In order to access these 
services, you must have a TCP/IP network transport interface with a special Windows DLL called 
WINSOCK.DLL installed on your system.

POP3 services allow you to retrieve new mail held for you on another machine (usually a unix machine or
a NetWare file server).

SMTP services allow you to send mail to the Internet; WinPMail implements SMTP mail using a relay 
service - that is, it asks a complete SMTP implementation (usually running on a unix machine) to send the
mail on its behalf.

Configuring WinPMail for network mail services

If you have a valid WinSock implementation installed on your system, three extra options will appear on 
your FILE menu. The first option allows you to configure WinPMail's use of these services.

TCP/IP timeout value:    This setting controls how long Pegasus Mail should wait for responses on your 
network before assuming that a problem has occurred. On fast networks such as Ethernet, you should set 
this to a relatively small value, such as 15 seconds. On slow links such as SLIP or PPP, however, 
considerably longer values may be appropriate. If you find that Pegasus Mail is frequently reporting 
network errors, try increasing this value to a larger setting.

POP3 host  The name of the machine where the account you wish to access is located. The address you 
provide here depends on your WinSock implementation: many will allow you to enter a normal internet 
name (for example, parnassus.pmail.gen.nz), but some may require that you enter the address in dotted 
notation (for example, 192.156.225.2). Consult your system manager or WinSock manual if you are 
unsure which form to use.

Username    The name of the account on the machine under which mail is being held for you. WinPMail 
logs into the host using this account name and retrieves any mail waiting there.

Password    The password for the account on the host. The password is not displayed on the screen and is 
stored in an encrypted format in your configuration file.

Leave mail larger than    If you are connected to the mail host by a slow TCP/IP link (such as a SLIP link)
then downloading large messages can be very time consuming. If you enter a value in this field, 
WinPMail will not attempt to retrieve any mail larger than the size you specify (in kilobytes) - it will be 
left untouched on the host. A value of 0 in this field means no limit - WinPMail will download all mail.

Delete mail retrieved on host    If you check this box, WinPMail will delete the host's copy of each mail 
message it successfully downloads, which will prevent it from being presented to you again the next time 
you retrieve mail. Leaving this box unchecked tells WinPMail to leave the mail on the host even if 
successfully downloaded. Mail left on the server will be retrieved every time you download mail.

Check when opening new mail    If you check this box, WinPMail will check the host for new mail every 
time you open the new mail folder or click the New Mail button in the button panel. If you leave this 
button unchecked, then WinPMail will only check for new mail when you explicitly choose Check host 
for new mail from the File menu.



Poll new mail after x secs idle    This option controls whether or not WinPMail should poll your POP3 
host for new mail automatically, and if so, how often. Enter here a number of seconds between poll cycles
(WinPMail is accurate to the nearest three seconds), and then if you leave WinPMail idle (no keystrokes 
or mouse presses) for this length of time it will automatically check for new mail. A value of zero means 
that WinPMail should never poll the POP3 host automatically    you will have to initiate the check 
yourself.

Message count only on idle poll    If this control is checked and you have set an idle poll cycle (see the last
entry) then WinPMail will simply check the number of new mail messages on each idle check and report 
that number on the status bar. If this control is unchecked, WinPMail will automatically download any 
new mail it finds on the host on each idle check.

Allow checks when minimized  By default, Pegasus Mail does not check the remote host for new mail 
periodically when it is minimized on your desktop, in order to reduce loading on your system and to 
eliminate the "jerkiness" the extra activity produces. With many versions of WINSOCK.DLL, however, 
the loading incurred by background checking is quite light, so if you would like Pegasus Mail to check 
while in the background then click this control.

Relay host    Enter here the name of a machine which can process outgoing mail on your behalf. This is 
usually the same machine you entered as your POP3 mail host, and the address is subject to the same 
restrictions and rules described there.

From field  WinPMail allows you to specify your own from field in outgoing messages. This facility is 
provided only to allow you to conform with local addressing schemes or requirements and should not be 
used capriciously. In order to prevent message forgery using this feature, WinPMail will only send mail if 
you have entered a valid username and password in the POP3 section of the configuration dialog, and will
check the validity of these details when sending. The valid POP3 address is written into a field in the 
message for security reasons.

Send mail at once (don't queue)    If you check this, WinPMail will send your mail messages to the relay 
host as soon as you click the Send button in the message editor. If you leave the box unchecked, 
WinPMail will queue your messages, and will only send them to the relay host when you explicitly 
choose Send all queued mail from the File menu. If you are using a slow TCP/IP link, you should 
probably leave this box unchecked.

Prefer for outgoing Internet mail    This option is only meaningful when you are running WinPMail on a 
NetWare system which is also served by either the Mercury SMTP transport or the Charon Internet mail 
gateway. Checking this control tells WinPMail to use its own built-in mail delivery routines instead of 
passing your outgoing mail to Mercury or Charon for processing. If you leave this box unchecked, then 
WinPMail will always use Mercury or Charon in preference to its own SMTP delivery routines if either is
available on the NetWare system to which you are connected. The setting of this control is ignored when 
you run WinPMail in a non-NetWare environment.

Use for all outgoing mail:    Usually when you enter an address such as "DAVID", which has no domain 
portion, Pegasus Mail regards it as a local address and attempts to deliver it to the user based on the 
assumption that he can be found on the machine you are using. If you are the only person who uses your 
computer, however, then there will be no other users on your system and this assumption will not be 
valid. Checking this control tells Pegasus Mail to pass all mail to the remote host for processing and not 
to presume that any addresses are local to your machine. You should only check this control if you are the
only person who uses your machine.





WinSock, or the Windows Sockets Interface is a standard way of providing network services under 
Microsoft windows. WinSock is usually used to provide access to the Internet TCP/IP network protocols 
although it can in theory provide other services as well. The advantage of WinSock is that applications 
can use Network services without knowing anything about the vendor-specific details of the transport 
modules installed on your system. This means that WinPMail can use any WinSock implementation no 
matter which vendor supplies it nor how it is actually implemented at the hardware level.

WinSock support is always provided by means of a DLL called WINSOCK.DLL which will be installed 
in either your Windows directory or somewhere on the path.



POP3 (Post Office Protocol, version 3) is an Internet standard which defines a mechanism for accessing a
mailbox located on a remote host machine. In order to use POP3 services, you require a user identity, or 
account on the host machine; when people send mail to you, they send it to your account on the host, 
which receives it and stores it in a mailbox for you. The next step is to run a program which supports the 
POP3 protocol (such as WinPMail): the program logs into the remote host on your behalf and copies any 
unread mail on the host to your local machine for reading. The copy of the mail remaining on the remote 
host can then be deleted (although most POP3 mailers make deletion an option).

POP3 is a necessary protocol because your PC will usually not be running all the time and hence will not 
always be available to receive mail directly from the Internet. A larger machine, such as a Unix system, 
typically will be on all the time, and so is better suited to receiving your mail for you. POP3 only defines 
the retrieval of new mail - mail is sent using the SMTP protocol.

POP3 is described in detail in several RFCs (Internet Standards Documents); the document on which 
WinPMail's POP3 implementation is based is RFC1225.



SMTP (Simple Mail Transfer Protocol) is the standard mechanism by which mail is delivered on the 
Internet and on TCP/IP networks. A very old protocol, its qualities are its robustness and ease of 
implementation. On the negative side of the ledger, SMTP is an extremely primitive protocol with no 
well-defined support for non-text attachments or international character sets. Because SMTP was 
originally designed for large multitasking systems which run continuously, it has certain design 
characteristics which make the reception of mail on PCs a difficult proposition. Because of this, most PC-
based mailers which use the TCP/IP network protocols use SMTP to send mail, but use another protocol 
called POP3 to receive mail. WinPMail uses this approach.

With over 15 million connectable addresses, SMTP is currently the most widely-used electronic mail 
protocol in the world and is likely to remain a potent force for several years. The SMTP protocol is 
documented in the Internet standards document RFC-821.



Setup for standalone operation

Welcome to Pegasus Mail! Before you begin using the program, you will have to provide Pegasus Mail 
with a small amount of information about your system and its configuration. This is needed so that 
Pegasus Mail knows where to store your mail folders, address books and other mail-related files, and so 
that it knows who you are.

The screen in front of you has three fields you should fill in. The first, Home mail path, is the DOS path 
to the directory in which your home mail folder should be located. The default value, C:\PMAIL\~8, 
tells Pegasus Mail to use the directory C:\PMAIL: the special string ~8 stands for the first eight 
characters of your username, and is replaced by Pegasus Mail before it uses the path. So, if you entered 
Peter as your username, Pegasus Mail would set your home mailbox location to C:\PMAIL\PETER. 
Using the special substitution this way means that more than one person may use the mail system on the 
same machine and ensures that their mail is kept separate. If you prefer not to use drive C: for your mail, 
or if for any other reason you need to change the path, you may do so provided the path you enter is legal,
although we recommend you use the default value unless you have good reasons to change it. The path 
you supply need not exist - Pegasus Mail will create it as necessary.

Your user name:    Enter in this field the name by which Pegasus Mail will recognize you. As described 
above, you can tell Pegasus Mail to use the first eight characters of this name as a way of identifying your
home mailbox. Please ensure that your username contains only letters and numbers - it must not contain 
spaces or special characters.

Save your username in WIN.INI:    Usually, when you start Pegasus Mail, it will open a small dialog 
asking for your username. If you are the only person using this system, you can bypass this step by telling
WinPMail to store your username in the Windows setup file, WIN.INI. Once you have done this, the 
system will always run using the name you supply, so do not check this control if there are other people 
using this system for mail as well. You can also specify the username WinPMail should use by means of a
DOS environment variable called PMUSER.



Noticeboards

Pegasus Mail's noticeboard system is like your own mail folders, the principal difference being that 
people other than you can see them and read the messages they contain.

A noticeboard may contain both notices, which you can read by pressing <Return> (the same way as in a 
regular mail folder), and can also contain other noticeboards. If you double-click on a noticeboard entry, 
Pegasus Mail will open that noticeboard and show its contents in the list. If you have opened a 
noticeboard, then there will always be a special entry at the top of the list marked .., which will take you 
back to the parent noticeboard.

Noticeboards have two names - a short name, which is used by Pegasus Mail to keep track of where you 
are, and a long name which contains a description of the purpose of the noticeboard. Short names are 
joined together with period characters to create paths, showing where a noticeboard fits into the hierarchy 
of noticeboards - so, the topic comp.sys.mail refers to a topic called mail which can be found in another 
topic called sys, which in turn is found in the topic comp.

If you are permitted to post notices in the current noticeboard, then the text Post will appear next to the 
topic's entry in the list: in a read-only topic you may only read the message, not add or delete them. If you
have administrator rights in the current board, the word Administrator will appear next to the topic's entry.
As an administrator, you can delete messages in    the noticeboard, and create new noticeboards within it. 
Administrators are also automatically allowed to post and read messages in the topic.

Posting notices
Following up
Administration



Posting notices

If the noticeboard administrator has permitted you to do so, you can posting a new notice on the board by 
clicking the New post button. You can only post into the currently-displayed noticeboard - it is not 
currently possible to 'cross-post' to other boards.

Posting a notice is a simplified version of posting a mail message - you only have to enter a subject and 
then type in your notice. Pegasus Mail automatically supplies the name of the noticeboard in which the 
notice is to be placed. 

While you compose your notice, you can add attachments to it in exactly the same way as you would to a 
mail message, by clicking the Attachments button or by pressing <F7>.

To finish your notice and post it to the noticeboard, Click Send or press <Ctrl+Enter>. Your notice will 
appear on the noticeboard immediately.



Following up

Following up is the process of posting a public reply to a notice which is already in the board. Think of a 
followup as being your contribution to an ongoing conversation.

Followups are always posted into the same board as the notice to which they refer. You cannot change the 
subject field of a followup - Pegasus Mail automatically sets it to the subject of the original message 
prefixed with the characters Re:. The reason you can't alter the subject is to ensure that all notices on a 
particular topic will be grouped together when people use the Sort by subject sorting option.

If you want to post an entirely new notice (one with a new subject field), but want to copy some text from
an existing notice, read the original notice, mark and copy the text you want from the notice, then post a 
new message, and use the Paste or ^V command command to insert the text you copied into your new 
posting.



Noticeboard Administration

Noticeboards cannot be directly administered from within this release of Pegasus Mail for Windows, 
although it will be possible in future versions. In order to administer a noticeboard, you must either use 
Pegasus Mail for DOS v3.1 or later, or manually edit the NB.ID file in each noticeboard directory. NB.ID 
is a simple text file containing instructions which tell Pegasus Mail how to work with the noticeboard.

Creating a noticeboard:  Follow these steps to create a noticeboard 

1: Start a DOS shell, and create a subdirectory in the noticeboard where the new noticeboard is to appear. 
Any name will do for the directory.

2: In the new directory, use a text editor to create a file called NB.ID. NB.ID can contain the following 
keywords:

Long name: The full name of the board
Short name: The abbreviated name of the board
Administrator: ID of a user who administers the board
Post: ID of a user who can post to this board.
Browse: ID of a user who can read notices in the board.

Post, Browse and Administrator each take only a single user ID, but may appear multiple times in the file.
On NetWare systems you can specify NetWare groups in these fields by prefixing the name of the group 
with a # character.

Rights: When you create a noticeboard in Pegasus Mail, you are really working within two different sets 
of rights; there are the rights that Pegasus Mail applies to a noticeboard to determine whether or not a 
person can see it and its messages, and there is also the actual operating system rights which apply to the 
directory structure on the disk. If the operating system and Pegasus Mail do not agree on the rights 
assignments, things won't work.

As an example, just because you have told Pegasus Mail that user "JBLOGGS" can post messages in a 
particular noticeboard, it does not follow that he will be able to do so if he does not actually have the 
operating systems rights to create files in the noticeboard directory.

As a result, for each class of user for a noticeboard (Administrator, Browser and Poster) you will typically
have to run some kind of command on your LAN which allows the user the actual physical access he 
needs to operate as indicated within a noticeboard.

A topic administrator must have at least the rights required on your system to be able to create and 
remove files and directories in the board directory.

A topic browser must have at least the rights needed to be able to see and open files in the directory.

A topic poster must have the rights of a browser and whatever else is needed to create and write files in 
the directory.

If you are running under NetWare 3.x or earlier, then you will have to use the NetWare "GRANT" 
command to assign appropriate rights for each type of poster.




